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Preface

This documentation is organized under the following headings:

Supported operating systemplatforms andbrowsers. Java prerequisites
and hardware requirements.

System Requirements

Describes how to install NaturalONE with the Software AG Installer.Installing NaturalONE

Describes how to proceed if you want to use NaturalONE in your
existing Eclipse environment.

Using Your Own Eclipse

Lists the requirements if you prefer to use your own Natural
Development Server (NDV) environment instead of the local Natural
runtime that is installed with NaturalONE.

Using an Existing Natural
Development Server Environment

Describes how to proceed if you want to configure an EntireX RPC
environment (Broker and Natural RPC server) instead of using the
default configuration of the one that is installed with NaturalONE.

UsinganEntireXRPCEnvironment

For important last-minute information, see the readme file that is provided with NaturalONE.

v



vi



1 System Requirements

■ Supported Operating System Platforms ................................................................................................. 2
■ Supported Browsers .......................................................................................................................... 2
■ Supported Natural Servers .................................................................................................................. 3
■ Eclipse Prerequisites ......................................................................................................................... 3
■ Java Prerequisites ............................................................................................................................. 3
■ Hardware Requirements ..................................................................................................................... 3
■ Recommendation for Huge Natural Applications Developed with NaturalONE ............................................... 4

1



Supported Operating System Platforms

NaturalONE supports the following operating system platforms:

Microsoft Windows XP Professional (x86)
Microsoft Windows Vista (x86)
Microsoft Windows 7 (x86)
Microsoft Windows 7 (x86-64) *

Microsoft Windows Server 2003 Standard Edition (x86)
Microsoft Windows Server 2003 Enterprise Edition (x86)
Microsoft Windows Server 2008 R1 (x86)
Microsoft Windows Server 2008 R1 (x86-64) *

Microsoft Windows Server 2008 R2 (x86-64) *

SUSE Linux Enterprise Server 11 (x86)
SUSE Linux Enterprise Server 11 (x86-64)
Red Hat Enterprise Linux Server 5 (x86)
Red Hat Enterprise Linux Server 5 (x86-64)

* For Windows, the runtime components of NaturalONE are always 32-bit applications, even on
64-bit platforms.

Supported Browsers

NaturalONE supports the following browsers:

Internet Explorer 7 through 9
Mozilla Firefox 3.6 through 10 (1)

Safari 5.1 on Windows
Google Chrome (2)

Notes:

(1)Mozilla Firefox 10 (Extended Support Release) is supported. In future versions, only the Extended
Support Releases of Mozilla Firefox will be explicitly supported.

(2) The Google Chrome support is based on Google Chrome Version 19. Due to frequent version
upgrades of Google Chrome, compatibility ofNaturalONEwith future versions of Google Chrome
cannot be fully guaranteed. Possible incompatibilities will be removed during the regular main-
tenance process of NaturalONE.
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Supported Natural Servers

To get full functionality of NaturalONE, specificNatural versions are required. For further inform-
ation, see Using an Existing Natural Development Server Environment.

Eclipse Prerequisites

Eclipse Version 3.6 is automatically installed with NaturalONE.

If you prefer to use NaturalONE in your existing Eclipse environment, Eclipse Version 3.6 is re-
quired. For further information, see Using Your Own Eclipse.

Java Prerequisites

OnWindows, Java is automatically installed with NaturalONE when you start the Software AG
Installer wizard using the .exe file. No further steps are required. However, when you want to
start the installer using the .jar file instead of the .exe file, Oracle Java Version 1.6 must already be
installed. This is required to run the installer.

On Linux, Java is not installed with NaturalONE. Oracle Java Version 1.6 is required in this case.
You can download this from http://www.oracle.com/technetwork/java/javase/downloads/in-
dex.html.

Note: IBM Java or the GCJ Java should not be used with our products for Linux x86 and
x86-64 platforms. Use only Oracle Java for our products on Linux x86 and x86-64.

Hardware Requirements

The table below lists the minimum hardware requirements for NaturalONE.

Important: The hardware requirements below are forNaturalONE only. They do not include
200MBof hard drive space for SoftwareAG infrastructure shared libraries required bymost
products and installed once per installation directory. They do not include requirements
for supporting software such as RDBMSs. Youmust determine the overall hardware require-
ments for each of yourmachines based on the overall requirements of your operating system
and software.
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Hard Drive SpaceProduct

970 MBEclipse development installation without runtimes

1 GBEclipse development installation with NaturalONE runtime

1.8 GBEclipse development installation with service enabling and NaturalONE and EntireX
runtimes

Recommendation for HugeNatural ApplicationsDevelopedwith NaturalONE

If you handle huge applications with NaturalONE (for example, if you have more than 20,000
Natural objects or huge Natural sources), is recommended that you install NaturalONE on a 64-
bit operating system. This ensures that NaturalONE can get more required memory than on a 32-
bit operating system.

To make use of a larger amount of memory on a 64-bit operating system, you have to adapt the
Eclipse.inifile in theNaturalONE installationdirectory (<NaturalONE-installation-directory>\ec-
lipse\v36\Eclipse.ini). Because the required amount of memory is application-dependant, it is not
possible to give definite recommendations on how the parameters in this file should be set. Getting
the appropriate values is an iterative process.

A good starting point for your own configuration tests are the following parameter values in the
Eclipse.ini file:

--launcher.XXMaxPermSize
512m
-Xmx2048m

XXMaxPermSize is used for static data. A value of 512 MB should be a sufficient setting.

You may change the Xmx parameter which specifies the maximum amount of memory that the
Java runtime is able to get. With the value in the above example, you allocate 2048 MB.
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General Information

This document provides product-specific instructions for installing NaturalONE. It is intended
for use with Using the Software AG Installer. That guide explains how to prepare your machine to
use the Software AG Installer, and how to use the Software AG Installer and Software AG Unin-
staller to install and uninstall your products. The most up-to-date version of Using the Software
AG Installer is always available in the NaturalONE product documentation at http://documenta-
tion.softwareag.com/.

Typical Development Installation

NaturalONE is part of the Software AG Designer. The following graphic shows the NaturalONE
components that can be installed with NaturalONE. The Application Development functionality
is mandatory; NaturalONE cannot be installed without this. The other components are optional.
Some of the optional components require that additional software is installed on a server. See also
What is NaturalONE? in the Introduction.
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Note: NaturalONE's Lifecycle Manager is not included in the above graphic since it has no
dedicated Eclipse plug-in. The Lifecycle Manager makes use of CentraSite Control which
runs in a browser.

Before You Begin

SoftwareAG strongly recommends that you create an installation image of your Software products
and store it on your internal network before installing. You should create an image for each oper-
ating system covered by your license agreement on which you plan to install (for example, 32-bit,
64-bit, or both). This will help you reduce WAN traffic and speed up installation, and ensure
consistency across installations over time, since the installer provides only the latest release of
each product.
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Shut down all products that are running on the machine on which you are going to install. To be
on the safe side, also shut down all Software AG services; use the instructions provided in the
documentation of the corresponding Software AG product.

Important: For some Software AG products, the uninstaller will not be able to remove key
files that are locked by the operating system if they are not shut down.

If you plan to install EntireX together with NaturalONE (NaturalONE's Service Development
functionality requires EntireX), read the information on EntireX in the InstallingwebMethods Products
guide before you start the NaturalONE installation. There you will find important information
on topics such as sudo authentication. Themost up-to-date version of InstallingwebMethods Products
is always available at http://documentation.softwareag.com/.

Installing NaturalONE Using the Wizard

NaturalONE uses the Software AG Installer. This installation documentation provides just a brief
description on how to install NaturalONEdirectly on the targetmachine using the installerwizard.
For detailed information on the installer wizard, see Using the Software AG Installer.

Note: SeeUsing the Software AG Installer also if youwant to use consolemode, or if youwant
to install using an installation script or installation image.

It is possible to install parallel versions of NaturalONE on one machine. In this case, you have to
install each version into a separate directory.

To install NaturalONE

Software AG provides a license file for NaturalONE; the installer requires it during installation.
Copy the license file to the machine on which you want to install NaturalONE. You can copy it to
any temporary location. The installer will ask for the location of your license file and will then
copy it to the appropriate location.

1 Start the Software AG Installer as described in Using the Software AG Installer.

2 When the first page of the Software AG Installer wizard (the so-called Welcome panel) is
shown, choose theNext button repeatedly (and specify all required information on the shown
panels) until the panel containing the product selection tree appears.

For the installation of NaturalONE, the product selection tree provides the following entries:

■ Designer > NaturalONE
■ NaturalONE 8.2 SPn
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Application Development (which is shown when you expandDesigner > NaturalONE) is
always required. NaturalONE cannot be installed without this item. It contains the core
functionality of NaturalONEwhich consists of the basic functionality for Natural application
development plus the possibility to create rich internet applications that use the Ajax techno-
logy. All other items underDesigner >NaturalONE are optional components forNaturalONE.
See alsoWhat is NaturalONE in the Introduction.

A Software AG-supplied Eclipse and a number of shared plug-ins are always installed with
NaturalONE. Other items in the tree (such as EntireX) are only required for service develop-
ment (they are automatically selected when Service Development is also selected).

WhenDesigner > NaturalONE (or just an item in this node) is selected, theNaturalONE 8.2
SPn item at the bottom of the tree is automatically selected. This installs the integratedNatur-
alONE runtime environment (which is also referred to as the "local Natural runtime"). If you
want to use an already installedNatural runtime on the localmachine or on a remotemachine,
you can deselect the NaturalONE runtime. See also Using an Existing Natural Development
Server Environment.

3 To install the full functionality of NaturalONE, expand theDesigner node and selectNatur-
alONE.

All required items are automatically selected. This corresponds to theNaturalONEApplication
Development with Service enabling typical installation (see the description below).
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Or:

Choose the Typical Installations button to display the following dialog box.
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Select one of the following and choose theOK button:

■ NaturalONE Application Development
This installs the following, in addition to the Application Development core functionality:

Lifecycle Manager
Mainframe Tools
Natural Construct
Natural Engineer
Predict
NaturalONE runtime

■ NaturalONE Application Development with Service enabling
This installs the following, in addition to the Application Development core functionality:

Application Testing
Lifecycle Manager
Mainframe Tools
Natural Construct
Natural Engineer
Predict
Service Development
NaturalONE runtime
EntireX and many other items which are required by EntireX

Note: For NaturalONE, it is not required that you select EntireX in this dialog box.
EntireX is automatically installedwith the Application Testing or Service Development
component of NaturalONE.

4 If you want to install the NaturalONE documentation, expand the Documentation node in
the product selection tree and select the entry for NaturalONE.
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This is theHTMLdocumentationwhich also includes the PDFbooks (as providedon http://doc-
umentation.softwareag.com/). The location of the downloaded documentation is a central
directory named _documentation in the main installation directory.

Note: The Eclipse help for a selected NaturalONE component is always installed, re-
gardless of your selection in this panel.

5 Choose theNext button.

6 Read the license agreement, select the check box to agree to the terms of the license agreement,
and choose theNext button.

7 Enter the full path to the NaturalONE license file (or use the Browse button to select it from
a dialog box), and choose theNext button.

The installer will copy the NaturalONE license file to the common/conf directory of your Nat-
uralONE installation.

8 When EntireX was selected, additional panels appear (for example, a System Management
Hub panel and an EntireX panel). For detailed information on these panels, see the Installing
webMethods Products guide. The most up-to-date version of this guide is always available at
http://documentation.softwareag.com/.

9 On the last panel, review the items you have selected for installation. If the list is correct,
choose theNext button to start the installation process.

Completing the Installation

After NaturalONE has been installed, you can start it as described in Starting NaturalONEwhich
is part ofUsing NaturalONE. NaturalONE's core functionality can be used without further config-
uration. Additional configuration steps, however, are required in the following cases:

■ You want to use an Eclipse other than the Software AG-installed Eclipse. See Using Your Own
Eclipse.

■ You installed a complete development installation, with or without the NaturalONE runtime,
and you alsowant to use an existingNatural Development Server (NDV). SeeUsing an Existing
Natural Development Server Environment.

■ You installed theMainframe Tools component. This component includesMainframeNavigation,
which requires an Entire System Server environment. See Installation and Configuration in the
Mainframe Navigation documentation.

■ You installed the Natural Construct component, which requires a Natural Construct server en-
vironment. See Requirements in the Using Natural Construct section of the Code Generation docu-
mentation.
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■ You installed theNatural Engineer component, which requires a Natural Engineer server envir-
onment. See Setting Up a Natural Engineer Environment in the Natural Engineer documentation.

■ You installed the Predict component, which requires a Predict server environment. See Setting
Up a Predict Environment in the Predict Description and Generation documentation.

■ You installed the Service Development component, which requires a Natural Business Services
server environment. See Before You Start in the Business Services documentation.

■ You installed a complete development installationwith service-enabling, but you did not install
EntireX because youwant to use an existing EntireX on the local or a remotemachine. SeeUsing
an EntireX RPC Environment.

■ You installed the Lifecycle Manager component, which requires a CentraSite environment. See
System Requirements and Installation and Configuration in the Lifecycle Manager documentation.

Online Help on Linux

In order to display the NaturalONE online help in Eclipse, it is required to set the Linux environ-
ment variable no_proxy in /etc/sysconfig/proxy to "localhost".

Updating and Migrating NaturalONE from Version 8.2.1 to Version 8.2.7

If you want to update an existing NaturalONE Version 8.2.1 installation to Version 8.2.7, it is not
possible to do this as described below under Updating NaturalONE. Instead, you have to install a
parallel version of NaturalONE, that is, you have to install NaturalONE Version 8.2.7 into a sep-
arate directory (not into the same directory as NaturalONE Version 8.2.1).

For NaturalONE Version 8.2.7, you have to use a different workspace. You must not use the
workspace of a NaturalONE Version 8.2.1 installation.

After NaturalONEVersion 8.2.7 has been installed, you have to import yourNatural projects from
theNaturalONEVersion 8.2.1 workspace to the NaturalONEVersion 8.2.7 workspace. In case you
also make use of non-Software AG plug-ins, you have to reinstall these plug-ins in Eclipse (via
Help > Install New Software).
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Updating NaturalONE

The information below applies when NaturalONE Version 8.2.2 or a later version is installed and
you want to update to a newer version.

To update yourNaturalONE installation, you proceed as described under Installing NaturalONE
Using the Wizard. Make sure to specify the same information as for your first-time installation,
that is:

■ specify the same directory,
■ specify the same items to install (for example, if you have previously installed NaturalONE
using theNaturalONE Application Development with Service enabling typical installation,
use the same type of installation for the update).

Uninstalling NaturalONE

You uninstall NaturalONE using the Software AG Uninstaller. For information on how to use the
uninstaller, see the Using the Software AG Installer guide.
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3 Using Your Own Eclipse

The easiest and recommended way to install NaturalONE is to make use of the Software AG In-
staller. However, you may prefer to make use of your already existing Eclipse environment. In
this case, a specific version of Eclipse is required. See Eclipse Prerequisites in the section System
Requirements.

If you want to use NaturalONE in your existing Eclipse environment, you need the NaturalONE
Eclipse plug-ins. To get them, it is required that you do a regular installation using the Software
AG Installer first. When the installation has completed, you will find the required plug-ins in the
installation directory of the Software AG Designer. They are stored in <your-installation-dir-
ectory>\eclipse\updates. Now, you have to proceed as follows:

1. Install all NaturalONE plug-ins using the update manager of your Eclipse.

You have to install the plug-ins in the following order:

a. com.softwareag.common.zip

b. com.softwareag.cis.ide-82.zip

c. com.softwareag.naturalone.natural.ide-one82.zip

When the above plug-ins are installed, you can install the other NaturalONE plug-ins in any
order you like.

2. Copy the file naturalone.properties from the \eclipse\updates folder of the Designer installation
to the folder of your Eclipse installation which contains the file eclipse.exe. Normally, this is the
root folder of the Eclipse installation.

You can now use NaturalONE from within your own Eclipse environment.
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Prerequisites

If you prefer to use your own Natural Development Server (NDV) environment instead of the
local Natural runtime that is installed with NaturalONE, it is recommended that you upgrade
your Natural Development Server environment to the versions listed below. Only with these
versions, you will get the complete functionality of NaturalONE.

The recommended versions are:

■ Mainframe
Use one of the following combinations:
■ Natural Development Server Version 8.2.3 cumulative fix 1with theNaturalWeb I/O Interface.
Natural Version 8.2.3 cumulative fix 2.
Natural Security Version 8.2.3 cumulative fix 2.

■ NaturalDevelopment ServerVersion 2.2.7 cumulative fix 13with theNaturalWeb I/O Interface.
Natural Version 4.2.7 cumulative fix 14.
Natural Security Version 4.2.7 cumulative fix 14.

Important: When Natural Development Server runs on a mainframe, Unicode and code
page support must be enabled (with the Natural profile parameters CFICU and CP).

■ UNIX, OpenVMS or Windows
■ Natural Development Server Version 2.2.7 with the Natural Web I/O Interface.
■ Natural Version 6.3.13.
■ Natural Security Version 6.3.13.

■ Servlet Container
■ Natural for Ajax Version 8.2.7 on Apache Tomcat 6 (6.0.20 or above).

Note: Apache Tomcat is required by Ajax Developer. Execution and debugging of rich
internet applications, however, can be done with any application server or servlet
container on which Natural for Ajax is running.

If the above mentioned Natural or Natural Development Server versions are not installed in your
environment, specific Eclipse functionality does not work. However, NaturalONE as such can be
used.
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Startup Transactions

When aNaturalONE client connects to aNatural server, any startup transaction program executed
on the server must meet the following conditions:

■ It must not perform any screen I/Os.
■ It must be executed only once (that is, the Natural system variable *STARTUPmust be reset to
blank within the startup transaction).

■ It must terminate properly.

You have to check the source code of each startup transaction in question and, if necessary, change
it to meet these conditions.

If you adjust the relevant source-code sections within a startup transaction - in dependency of the
client type - you can use the Natural application programming interface (API) USR4218N in the
library SYSEXT. This API has to be invoked from within the startup transaction and provides you
with the client type.

Natural Security

WhenNatural Security is active in yourNatural server environment, several actions in theNatural
Server view and in theNavigator view (such as upload and download) are controlled by Natural
Security. A utility profile for SYSMAIN is then required inNatural Securitywhich has the appropriate
settings. For detailed information, see Protecting the Natural Development Environment in Eclipse in
the Natural Security documentation, which is part of the Natural documentation.

If the Natural Security settings are not appropriate, you may not be able, for example, to add
projects from the Natural server to the NaturalONE workspace.

Library Statistical Records on Mainframes

In order to reduce the number of Adabas calls and to improve the performance, it is highly recom-
mended that you create a so-called "library statistical record" for every Natural library on the
mainframe. This ensures that data which is often used is kept persistently. Thus, when using
NaturalONE, there is no need to retrieve this specific information many times. To initialize the
statistical records, you have to invoke the program NDVCSTARwhich is available on themainframe.
For further information, see SPoD-Specific Limitations and Considerations in theNatural Development
Server documentation for the appropriate platform.

19Installation

Using an Existing Natural Development Server Environment



Database Access

You can access Adabas databases when they are on the same PC as your NaturalONE installation.

However, in order to access remote Adabas database systems, Entire Net-Work is required. Cur-
rently, you have to configure your environment accordingly. For remote access to Adabas 6 (Open
Systems) or Adabas 8 (Mainframe), Entire Net-Work 7.3.2 is required.
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5 Using an EntireX RPC Environment

EntireX is required if you want to develop Natural business services and RPC clients with Natur-
alONE. This is supported by the optional EntireX andBusiness Services components ofNaturalONE.
This is sufficient for testing RPC clients forNatural subprograms. TestingNatural Business Services
clients, however, requires an additional Natural Business Services installation as described under
Before You Start in the Business Services documentation.

If you prefer to use a different EntireX RPC environment (Broker andNatural RPC server) instead
of the one that is installed with NaturalONE, specify this as follows for those components for
which you need a custom EntireX RPC environment:

■ RPC Environments Preferences
On theRPCEnvironments page of the EntireX preferences, add your customRPC environment
to the list of predefined RPC environments (Window > Preferences > Software AG > EntireX
> RPC Environments).

■ EntireX Natural Wrapper
In the EntireX Natural Wrapper wizard (Generate Natural from Software AG IDL command
in the context menu of an IDL file), choose either an RPC environment from the list defined on
the RPC Environments preference page, or create a new RPC environment definition (which
is then added to the list on the RPC Environments preference page).

■ EntireX IDL Extractor for Natural
In the IDL Extractor for Natural wizard (which is started withNew > Other > Software AG >
EntireX > IDL Extractor for Natural), choose either an RPC environment from the list defined
on theRPCEnvironments preference page, or create a newRPC environment definition (which
is then added to the list on the RPC Environments preference page).

■ Natural Subprogram Tester
If you run theNatural subprogram tester on aNatural subprogram (Test Subprogram command
in the context menu of the Natural subprogram (NSN file), specify your Broker ID and server
address on the Connection tab of the tester user interface.
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■ EntireX IDL Tester
If you run the IDL tester on an IDL file (Test Software AG IDL command in the context menu
of the IDL file), specify your custom Broker ID and server address in the tester user interface.

■ General EntireX IDL Preferences
On the EntireX preference page, define your custom Broker ID and RPC server address that is
to be used as the default RPC environment with the EntireX wrappers (Window > Preferences
> Software AG > EntireX).

■ IDL File Properties
In the properties of an IDLfile (Properties command in the contextmenu of the IDLfile), specify
your custom Broker ID and RPC server address that is to be used by the EntireX Wrappers for
this IDL file. You do this in the general EntireX section and in the EntireXWeb ServicesWrapper
section (on theMapping tab).

■ WS-Stack Configuration Editor
In the WS-stack configuration editor, configure an EntireX web service (AAR file) to use your
customBroker ID andRPC server. To do so, open theweb service archive (.aar) and on theEntireX
Settings tab, specify your custom Broker ID and RPC server address to be used. Save the mod-
ified .aar file and redeploy it.

See also EntireX Workbenchwhich is part of the EntireX documentation.
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